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Introduction

Communicate: In Print 2 is a Desk Top Publishing program for making printed
worksheets and books. It has the benefit that it can easily support writing with
pictures or symbols as an aid to literacy. It is provided with the Widgit Symbol set,
that has some 11,000 line drawings to support literacy in both colour and black &
white. There are also over 1500 coloured graphics and photographs. These coloured
pictures can be used on their own or put together to build scenes to illustrate writing.
You can also use your own images in the program.

The Widgit Symbol set has been developed in consultation with many language
specialists and has an underpinning structure to aid communication. The basic
principles of using symbols are described at http://www.widgit.com/symbols/.

This tutorial booklet provides an introduction to the program. If you follow this
booklet through, you will create an 8 page book that uses all of the key features of
the program. We urge you to work through this, it will not take long, and will give
you a good grasp of the program to get you started.

There is also an extensive electronic reference manual, which is searchable. Click on
Help, on the menu, to access this.

For a full reference manual for Communicate: In Print 2 see the Start> Programs menu
when you have installed the software. The most up to date version of the Reference
Manual can also be accessed on-line at http://www.widgit.com/help/inprint

A PDF copy of the documentation is also provided on the CD if you wish to have a
printed reference manual.

The Widgit web site will also have a large number of example files and practical tips
on using Communicate: In Print 2 in English.
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Introduction to Communicate: In Print 2

A tutorial to show you the key features of the program.

1.

Starting to write

e Open the program

This is the main creative writing screen. This shows the main toolbars. It is possible to
have a range of simpler toolbars. If someone has previously changed the setting you
can find how to change it back in Section 12.
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This shows the main toolbars and on the right there is the Edit Panel for formatting
your writing. The four writing buttons on the left show the different kinds of writing
frame that you can make. You can write in a frame that freely expands as you write,
or in a frame of fixed size where the contents will be automatically adjusted to fit

in the frame. These frames can be for plain text or for symbol supported text. The
buttons shown below allow you to choose the type of writing frame you want.

!

il

—
-
i
=]

v
Lo

—
-
g
o

il

The ol
and the
pussycat

The ol
and the
pussycat

Free Symbol frame for writing freely in symbol supported text.

Fixed Symbol frame has a fixed size so that the contents are automatically
sized if necessary to fit into the space.

Free text frame that will expand as you write to fit the contents.

Fixed Text frame where the text is sized to fit.
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1a.

Writing with symbols

Click on the Free Symbol writing button. :‘Q‘

Drag a box for writing on the page as shown opposite.

Into this box type A book about In Print.

Notice that the symbol appears when you enter the space following
each word.

As you finish each word look at the symbol choices box on the right, at
the bottom of the Edit Panel. It shows all the graphic options for that
word. Change the displayed graphic by clicking in an alternative.

You may want to ‘turn off’ the symbol attached to a word.
Click in the Hide Symbol button in the Symbol Choices viewer.

1b. Using coloured or monochrome symbols

1c.

Click on the icon that informs you that you are using the coloured
images.

You will see that the symbols change to black and white and that the
icon changes to indicate this.

Highlight just the words “in print”. Now switch between colour and
monochrome. You will see that only the highlighted sections change.
This enables you to have documents with mixed black and white and
coloured symbols.

Type the word “happy” making sure that you are showing coloured
symbols. This brings up a face which has the default skin tone. Click on
the skin tone icon repeatedly to see the five different skin tones.

To change the skin tone for just one symbol make sure it is highlighted
before clicking the skin tone button.

Writing in a Fixed Text Frame

Click on the Fixed Text button. | I o

pussycat

Drag a new frame. This will add a Fixed text frame to your document
with a border ready to type in.

Into this frame type Getting started with pictures symbols and
words.
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e Right Click in the frame and you will see blue drag points appear.

Getting started with

pictures, symbols and words.

e Use the left mouse button to move the frame or to drag these points to
re-size the frame.

e Adjust the sizes and then move the two writing frames so that the
layout is similar to the illustration below.

e Right Click again in the frame to change the frame back into Create
mode.

* You can use the buttons in the panel on the right (the Edit Panel) to
adjust the positioning and appearance of text and graphics.

1d. Adding a picture

e Click on the Graphics button

This will change the panel on the right to show the Graphics Panel.

e The default area for the graphics source will be a folder called Widgit
Pictures. This has several folders of coloured graphics. Choose the
folder called General. Click on the picture of a book and then click back
in the centre of your page.

e Re-size the picture to make the page look similar to the screenshot
below.

Getting Started with
pictures symbols and words

DGeS

A book about In Print




. Speech bubbles

Turn to the next page by clicking on the Next Page button in the mlpy
bottom navigation toolbar. V)
If there isn't a page already there one will be created.

You can choose to see the document as single pages or as a double page

spread.
The buttons for choosing between these two displays are:

and

Set the display to single page. If the button is set to a double page,
change by clicking on it. It should change to a single page icon.

Add two graphics to the page from the animals folder: the camel and
the frog. The folder icon will take you back to the Widgit Pictures folder.

Click on the Speech Bubble button:

This will show the Speech Bubble panel. Below each style of bubble

there are four points, these represent the direction of the mouthpiece :
from the bubble.

Click on the point you want under your chosen bubble style and then b Ye
drag a frame on your document as below. 2K

You can type straight into the speech bubble. To display the editing
panel again, click on the Create icon (top, left).

To change the writing from text only into symbol writing use the

F10 key or click on the text or graphic button in the Edit Panel [] [ﬁ]
before you start to type.
@ {Communicate:m Print 2@
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You can change the direction of the mouthpiece at anytime.
e C(lick in the bubble you want to change and then click on the Speech Bubble

button again. This time choose from the four points at the bottom of the panel.
Clicking in these will change the orientation of the bubble.

e Use the Expand button to make the text (and symbols) as large as possible x
in the frame.
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3. Photographs and other pictures

Create a new page (number 3) using the right arrow button in the page
toolbar.

On this page add a large Fixed Symbol frame to fit the top half of the page.

3a. Setting the frame appearance

e C(Click in this frame and then click on the Frames and Pictures menu
and then select Appearance...

Set Frame Properties A ﬂ
Frame Appearance |
Set the appearance of your frame. The picture shows the effects of what
you chooze on one comer of the frame.
Border Colour I Border Colour Transparent |

Background Colour | Background Colour Transparent |

Line Colour | Line Colour Transparent |

Corner radiuz [mm] |5 ﬁ r

Lire Thickness (01 mm) [14 =
Border \width (0.2 mm) Ig 3:
Internal Space [0.2 mm) |1 3:

ok | Cancel |

e Change the appearance as shown above, and then click OK.

3b. Adding a photograph to fill a frame

i

e C(lick on the Graphics button in the left toolbar:

e Choose the Photos folder in the main Widgit Pictures.
e C(lick on the squirrel photograph and then click in the frame.
The picture will automatically fill the frame.
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3c. Adding photos to words instead of symbols
e C(lick on the Free Symbol writing button,and drag a box underneath the photo.

e Type into this There are squirrels and rabbits in the forest. This will be
automatically symbolised. It would be nice however to use real photographs for
‘squirrels’ and ‘rabbits’.

e Click on the Graphics button again, and then click first on the squirrel picture, and
then on the word squirrel. The symbol will be replaced by the photo.

e Repeat this for the rabbit.

e Click on the Graphics button again to remove the Graphic panel.

e If you click back in the word squirrel you will see that this has been added to the
symbol choices box.
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The choices available when you type are set by a ‘Wordlist’ It is possible to add this
graphic to your wordlist so that it can be used in other documents. This is done from
the Wordlists menu, via Save wordlist changes. Please don’t save this example,
however, in case somebody else wants to follow this tutorial. For further information
on wordlists look in the electronic Reference Manual. Click on Help on the Menu Bar
to obtain this manual.

If you are not sure what a picture represents you can right click on the thumbnail in
the Graphics Panel to see the filename and also to hear the name of the file.

3d. Changing the size of thumbnails

The default view of the Graphics browser shows three thumbnails on each line. You
can change this to show larger images from Thumbnails, under the View menu. This
will display one, two or three columns of images. The program automatically stores
the last used setting.

3e. Using your own pictures

When you open the Graphics panel the default area it opens

at is Widgit Pictures. However, you can navigate to anywhere @Eihotos [
on your computer or network to find your own pictures. =

Use the little down arrow beside the current folder name to
see the folder paths, or click on the folder icon with the up
arrow to move up a level:

You can easily return to the main Widgit Pictures by clicking
on that button at the bottom of the Graphics panel.

You can also designate two alternative areas that can be easily reached by clicking on
the Pictures A or Pictures B button.

By default Pictures A is linked to your My Pictures folder in My Documents.
Pictures B is linked to a folder called Shared Images that has been created for
you to store your own pictures in. The links to these areas are set up from the Start-
up Preferences. Go to the Options menu, Start-up preferences and then choose the
Graphic Locations tab. There is more information on the Start-up preferences in
section 11.

NOTE:

When you save a document, copies of any graphics that are not in a Widgit area are
saved with the document so that you can take that file to another machine with
Communicate: In Print installed, and you will not lose the pictures. There is more
information on graphics and saving files in the Electronic Manual, which can be found
in the Help menu.
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4. Building a scene

Create a new page (page 4).

Open the Graphics panel and then open the Animals folder.

Put two green dinosaurs on the page and make them large.

Hold down Shift when you re-size to keep the aspect ratio (ratio of height to
width). If you have distorted the picture you can always double click on a graphic
to restore the aspect ratio.

You can flip a graphic by dragging the right or left blue drag points right through
to the opposite side. Flip one of the dinosaurs now, as shown below.

&
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4a. Changing to Adjust mode

Up to now you have worked entirely in Create mode. To make adjustments to the
layout of the images you will need to change to Adjust mode. On the left toolbar
there is a button for each of these two modes.

x 1t

Click on the adjust mode button: 0k

The left toolbar changes to show you the Group and Arrange buttons, and the top
toolbar changes to show the rotate icon instead of speech and spelling. These are all
explained below. Another visual indication of the mode is the background colour.
Create mode is blue and Adjust mode is green.

4b. Editing the colours of Widgit Pictures and Symbols

Select one of the dinosaurs and click on the Palette button.

This will open the palette for this picture.

Click on any of the coloured parts of the dinosaur and you will see the matching
colour square highlighted.




Click on that colour square to get the colour dialog box. You can now choose a
different colour. Click OK on the colour palette. Do this for all of the colours until
you have a blue dinosaur. Then click OK on the panel. If you click Cancel at this
point the graphic will return to its previous colour palette.
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You can also change the colours within a coloured symbol. Simply click in the word
attached to it and then on the palette icon exactly as above.

4c. Arranging and Grouping

Create a small group of dinosaurs as a start to making a dinosaur scene. You can
stay in Adjust mode while you do this.

Use the Arrange buttons in the toolbar to change the front-to-back order of the
graphics.

| j Move to the front.

e
p—

Move forward one place.

Move backwards one place.

Move to the back.
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If you find that you cannot highlight a graphic because it is at the back and
underneath others, then hold down the control button and at the same time press
the left mouse button. Each time you press the mouse button a different item in the
‘stack’ is highlighted.

Grouping images

You may want to move or re-size the group of items that you have put together.

e C(lick on the group button. This will now start to flash.

Click on all of the items you want to group, and then click on the group button
again. The individual frames with blue drag points will be replaced by a single
group frame with yellow drag points.

Alternatively, you can drag over the set of images you want to group and then
click on the group button, or you can hold down CTRL + Shift and click in turn on

the images that you want to group. Click on the group button when they are all
highlighted.

e Use one of these yellow drag points to re-size the group or move it as a whole.

You can ungroup a set of items with the ungroup button:

To complete the scene, find a suitable background from the Environment folder.

e Size this to cover the whole group of dinosaurs.

e Then, click on the button to send it to the back: ﬁl
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You may want to adjust the position of individual items in the group to fit with the
background, without ungrouping the whole picture.

e Right click on the item you want to move. This will highlight an individual item.
You can then adjust its size or position with the right mouse button. It is still part
of the group and can still be moved as a whole.
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4d. Rotate

This feature is only available in Windows 2000, XP and above.

You can rotate individual graphic or text frames, but not groups.

e Ungroup the dinosaurs using the ungroup button.

e Select your item and then click on the rotate button.
The corner drag points change from square to round.
Drag one of these points to the desired position and release.

You can also rotate by setting the rotation angle from the Frames and Pictures
menu.

You cannot colour a rotated graphic, or edit the text in a rotated frame so it is best
to make all the changes you want before you rotate it. If you want to edit a rotated
frame double click on it and it will return to normal. Make any changes and then re-

rotate it.

Bitmap type files (such as photographs) can only be rotated at their original aspect
ratio. If you rotate a stretched bitmap graphic it will automatically be adjusted to its
original aspect first.

@ ;(Communicate:m Print 2 @




4e. Adding labels

e A label can be made with a Fixed writing frame with the border set to be
transparent.

abe
e Return to Create mode: =]

e Create a small Fixed Text writing frame and type in some text for the label.

* From the Frames and Pictures menu, go to set the Frame Appearance, click on
the button to make the border colour transparent, then set the line colour to
black.

* You could position the labels on the picture, or you could leave them at the
bottom of the page as an activity for a student to complete.
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To make this into an activity for a student, you may like to hide the panel on the
right.

e C(lick on the Hide panel button on the top toolbar:

You may also want the program to offer a simpler toolbar menu to students. These
can be found under the View menu. (See section 12)

For further examples see the examples folder - Activities to do on screen - Colour
book 2.
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5. More on layout and alignment

e C(Create a new page (Page 5).

e Create a Free Symbol writing frame and type in the following heading: Which
pictures are different. Even though this is a Free Symbol writing frame, you can
still add a border. Use the Frame Appearance to put a border around the heading.

e The symbol for Pictures may show the plural qualifiers. You can show or hide the
qualifiers via the View menu.

DGR Cam—

L B .
ole g

Which pictures are different

5a. Guides

e First add three horizontal guides so that you can line the pictures up. A
guide is picked up from the black lines at the top and left edges of the
background. As you move your mouse over the line the cursor changes.

e Drag the guide into place.

e Place the guides roughly in place to allow for three rows of pictures.

* You can hide and show your guides from the view menu.

5b. Rulers

e |f you want to arrange these guides accurately you can use the rulers to measure
the gaps and position the guides accurately.

e |f you cannot see the rulers on the page, go to the View menu and click on Show
Rulers.

* You can double click on a ruler to make it free floating. You can then drag the
blue bar at the top to position it where you want to measure.

e Double click again to return the ruler to its usual position.
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5¢. Locked Guides and Book Guides
You can LOCK the guides so that you don’t accidentally move them:

e Right click on the guide to see the guide menu. | Make I & BOEH gz
e Click on LOCK this guide in place. LOCK Ehis guide in place

e If you want to put a particular guide on every page — for example for a margin or
to line up a heading, then you can make any guide into a BOOK guide. Choose
this from the guide menu shown above. This will copy the guide to every page in
the book. If the guide is already locked then the Book guide will also be locked.
If not, then when you move the book guide on one page it will be moved on all

pages.

You can tell the status of a guide from its colour. Ordinary page guides are Green,
book guides are Red and locked guides are Grey.

5d. Duplicate

Add the images for the odd-one-out activity as described below:

Line 1: Reflection - This will have one item flipped horizontally.

Put a graphic on the first line.

Click on the Duplicate button to make three copies of the same frame. .

Click on one of these and drag it through itself to flip it.
Arrange these evenly along the line.
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Line 2: Colour - this will have one item coloured differently.

1. Put four copies of an item on the next line as you did before.
2. Go to Adjust mode and select one item to colour.
3. Click on the palette button and change the colours as you did previously.

Line 3: Rotate — one item will be at a different angle to the others.

e Put your four graphics on the line.

e C(lick on one of the graphics and then on the rotate button.

e Use one of the corner drag points to rotate the picture so that it looks different
from the others.

Gommunicawln Print 2



6. Tables

6.1 Creating a table

You can create tables from a text or symbol frame.

e C(Create a new page (Page 6).

e Create a graphic frame using the Fixed Symbol writing button, and set the
appearance as shown below:

Set Frame Appearance x|
Frame Appearance |
Set the appearance of you frame. The picture shows the effects of what
you chaase on one comer of the ame,
Border Colowr | Border Colow Transparent |
Background Colour | Hackaiound Colour Transparent |
{Line Colowr | Line Colou Transparent |

Camer radius (mm) = (|; ________
Line Thickness (01 mm) [ =]
Boder Widh 02nm) [ =
Internl Spacs 02mm) [T =]

0K Cancel

The border is set to be transparent but with a width of 8. This will set up a
transparent gap between the frames in the table.

e Set the other properties of this frame, such as centre justify.

e Click in this frame and then go to the Frames and Pictures menu and click on
Make a Table. This will give you a dialog box to enter the number of frames you
want in the table and give you options to size the grid.

Create a Table x|

This will make a table using the selected frame as a
"template". S ap how many frames you require
across and how many down.

@ Fixed table size
" Fixed cell size

© Uss curert size

Cellz acrose T able width [mm] Cell width [mm]

=1
[2 = 132 B
Cells down T able height [rm] Cell height [mm]
=
E = [rea EE

Cancel |

e Fixed table size: This will be the size when printed. It will warn you if the size set
is larger than the paper.

* Fixed cell size: This sets the width and height of each cell in the grid. It will warn
you if the size set is larger than the paper.

e Use current size: This will make the table using the size of the cell created on
screen.

% Communicate!|n Print 2) @
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Click OK to create the table. The frames will be grouped and so the frame will have
yellow drag handles. You can move and re-size the table as a whole by moving the
yellow drag points.

e You will need to click away from the table then click back inside a cell.

____________________________________________________________________________________
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* You can now fill in the contents of the table as you wish.

6.2 Editing a table

¢ Re-size a table. To set a specific size select Edit table size, from the Frames and
Pictures menu.

e Insert rows or columns. Select a cell and then choose the option you want from
the Rows or Columns menus under the Frames and Pictures menu.

|Frames and Pictures  Speech  Options  Window

i Appearance... ]

ffake & batle...
Edit able size. .

Insert above
Zalurins 3 Insert Below
[Merge bable cells Delete
Unrerge kable cell

Fit cantent ta Frame
Make Full width -
Make Full height —

Copy frame ko pages...
Master items 4

Hotate: .
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e Altering column widths and row heights. Go to adjust mode (second button
on the left hand toolbar) and right button click a cell in the row or column you
want to change.

Drag the right hand A
blue drag point.

The cells in the

column are then

all automatically

highlighted and the

column width can be

changed.

Click away when you have adjusted the column. You can similarly adjust the row
height similarly.

¢ To merge cells. In adjust mode, select the cells you want to merge by left clicking
on them whilst holding down Shift+Ctrl. Then select Merge cells from the Frames
and Pictures menu.

y l l I
e Combining changing row heights/column widths with merging. You can
change the row height even if the row intersects a merged cell. Similarly with

column widths. The pictures below show how you can still change the width of the
middle column.

HH H=

e To unmerge a cell. Again in adjust mode right click in the cell. Then select
Unmerge cells from the Frames and Pictures menu. The cell will unmerge and
each cell takes it width and height from the relevant row or column.

@communcate:m Print 2)



Key Points to Remember.

(a)
(b)
(©

Go to adjust mode (second icon on the left) to make these types of changes.
Use a right button click to select a single cell in the table.

Hold down Ctrl+Shift and left button click in those cells you wish to highlight
together.

Change the appearance of one or more highlighted cells by going to
Appearance under the Frames and Pictures menu.
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Note: The heading on this page was added separately.

6.3 Printing large grids and overlays

The screen will normally indicate the printing limit of the currently installed printer.
This is the red dotted line near the edge of the paper. You will notice that as you
move items over this line they are clipped (and no longer show) to give a tidy edge to
the page and indicate what you will see when you print the page.

Some printers will actually print within some of that dotted area. So if you need a
grid very near the edge of the paper you may want to override the page clipping to
get the absolute maximum printing area. This can be done from the Options menu.

|O|:utions Window Help

Start-up preferences

Remove Page Clipping { for overlays )
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7. Lines, arrows and an alternative way to add pictures

e C(Create a new page (page 7).
e Put a heading Which words begin with b or d?

7a. Getting pictures from a list

It is easy to find the coloured pictures from the Widgit Pictures folder by navigating
to the relevant topic folder. It is also easy to find the symbol line drawings by typing
words into a Fixed Symbol writing frame. However there may be times when you
want to find pictures directly from a word, but not show the word in the document.

e Open the graphic panel, and click on the third tab on the top labelled Use List.

* You can choose whether you want to use the symbol list (from the current
wordlist) or picture list (the coloured pictures from the Widgit Pictures).

e Type the word to identify the picture you want and click Find.

* You will see all the pictures available for that word in that wordlist.
Click on the one you want and then click in the document to place it there.

EyEi i

i

=
&
2
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7b. Lines and Arrows

To add lines to your page, click on the Lines tab in the Graphics panel

e Choose whether you want single lines: ‘ /

or multiple connected lines: —-“\S‘\

The buttons are yellow when they are active, otherwise they have grey
backgrounds.

e |f you want horizontal or vertical lines then also choose the right-angle | |
line button: —
e Choose the arrow style (with or without head), the line thickness and finally the
line style.
e Click where you want to start the line. Do not hold the mouse button down.
As you move the mouse pointer you will see an indicator for the line.
e Click again to finish positioning the line.
e To stop drawing lines you can:
Double click
Click on the blue/green background
Click again on the line button.
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8. Building a document

You have now covered most of the main concepts of the program.
This section gives some additional help with building documents and introduces some

additional writing support facilities.

In this section you are going to create a page like the one shown below.

=8

LAY SR 2 akd | e
Communicate In Print B| n| 7] 8]
20 ] T L
ot = - e ’__\:‘ S j]E
Ths s a  new il save i |
g -& et qtbino gﬂiﬁ] ==
mnwwqmm to write = iz =] E E_J]
Bl " + o M=
in pctires and  words ’ v = 8 =B
2 | B&d

Ttie Fn to ume

Iy [ (@ (B[

There Is o pleterisl spell
chacker that lets you

Create another page (page 8).

Across the top type a title in text only.

Drag the mouse over this to highlight it.

Click on the Text larger button in the text editing panel until it is size 48: m

Click on the Bold and Shadow buttons to change the style:

e Open the graphics panel and click on the Lines tab.

e Add a horizontal line under the title and then a vertical line in the centre to make
two columns. You can edit a line by Right clicking on it to show the blue drag
points and then move it or change its appearance.

Communicate In Print

3 S
L i - - [ Use your own
| [

ne

Lo This Qs e photographs and save

i
@I _.< % them with the file.

computer program  fo  write

EE+

Lin pictures  and  words,
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e Use the different types of frames to create the example above with symbols, text
and pictures as shown, with the text size 20 and symbol size 16.

8a. Changing the words linked to a picture

When you write the caption ‘Squirrel found eating a toffee’ you will find that there is
no symbol for’ toffee’. The most suitable symbol is ‘sweet’.

e Type the phrase with the word sweet, to get the symbol you want. Then click in
the word ‘sweet.’

cat

e Click on the Change Text button to remove the text. ng

e Type in the new word ‘toffee’. Press the right arrow key on the keyboard.
e |tis possible to save this change to your wordlist from the wordlist menu. There is
more on wordlists in the manual.

8bh. Zoom

When you are placing a lot of content on a page it may be easier to zoom in
on the page.

ke;

f
§
|

You can zoom out or return to Fit to Window using the other buttons.

|

8c. Speech

You can listen to the text in a frame using the Speak button.
Click in the first word in the top left symbol writing frame.

e Click the speak button to hear the first sentence.
e Click it again to hear the next sentence.
This way you can click through a frame listening to each sentence in turn.

e C(lick on the repeat Speech button to hear a sentence again:

s

.
b

The speech in Communicate: In Print 2 is not intended for use as a talking
book, but only as a support for writing. Sometimes it is useful to have audio feedback
to help the construction of sentences as well as identifying spelling mistakes.

The program can work with SAPI4 or SAPI5 voices. If you choose SAPI4 from the

Speech menu SAPI4 or SAPI5 then a combo box appears from which you can select the
voice you require.

T F =7 6T
off] Ly one 3 obe] ()
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If you choose SAPI5 then this combo box disappears and the program will use the
default SAPI5 voice on your machine.

[ <0 % abe] "

The default machine SAPI5 voice can be changed from the Windows Control Panel
selecting the Speech button.

8d. Bullets and Indents

e Add a new Free Text frame underneath the “squirrel...toffee” frame, with a text
size of 18, then write in the text below.

B OF - &

Squirrel found  eating  a toffes

Squirrels usually eat:

® nuts

®  seeds

® berries :
Squirrels are very greedy and Wi”:
steal from birdseed holders,

e Add bullets with this button on the text panel: —

e Indent or cancel indent with these buttons: 4= and P=

8e. Spell Checker
There is a pictorial Spell checker to help.

Turn on the Spell checking features:
e From the Text menu tick the Mark spelling mistakes option.

| Text Frames and Pictures r' ---------
| | (hewn~
FDnt'I"F ;E live in  townz and
Align left t L
N ~ A
Centre %?? );% o i Tfm& :
flign right § P - :
el = + :
Fonk colour o ,3:: and gjfg m&j 5
¥ )
v Mark spelling mistakes o= it !! %ﬂ! +
Checkspelling iéare often  very tame and
Edit user dictionary
Mew suggestions 15@2& :
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* Into a Fixed symbol frame type the words shown above, including the mis-
spellings. I

e C(lick in a text or symbol frame and then on the spell checking button on v
the top toolbar. This will open the Spell checker panel. abe

=18] x|
aldlxl

| @ 2w )| ¢ Gdr I e

unm [SuirelE
Communicate in Print D

Use your own

photographs and save
them with the file.

i (3 (® [G[E (o

The spell checker shows the suggestions together with an illustration whenever
possible. In the example above there are both the symbols for squirrel and also the
photograph from page 3.

e Click on one of the words in the list, and then Try the new word.
You will see the word added to the document.

e C(lick on Hear the sentence. This may help in choosing the correct word.

e If, having seen and heard the word in context, you are not happy with your
choice, you can click on Back to original word to try a different alternative.

For some phonetic mis-spellings you may find that spell checkers do not suggest
alternatives. Communicate: In Print offers the facility for adding these. From the Text
menu select New Suggestions. In the top box enter the mis-spelling. In the lower
box enter all of the correct word suggestions relevant to that mis-spelling. Separate
different entries with a comma. Then click the bottom button to add this to the
speller.

Finish the document to match the picture.
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9. Page numbers and Master items

Lets finish this introduction with a few little extras:

9a. Page Numbers

e On Page 2 make a small fixed text box in the bottom centre.

e Into this type a ‘Not sign’ [This is obtained with shift on the key to the left of
number 1].

e Assoon as you have typed the ‘Not sign’ the text box will show the number of the
current page.

You may want this page to be page 1 and not page 2. You can start page numbering
at any page you want.

e To change the start page for page numbers go to the Edit menu.
Select Start Page numbers at...

Start Page Numbers At... x|

What actual page number do vou want to be
labelled as page 17

|2

Canicel |

e Enter 2 in the box. You will see that the page number on page 2 changes to be 1.

You will now want to put a page number on all the pages from page 3 onwards. Click
on the Frames and Pictures menu, and then on Copy frame to pages.

Paste Frames & Lines ﬂ

— Locking

V¥ Leave unlocked
[~ Lock position

[T Lock text and symbals

— Paste to pages:
wirite the pages to copy to e.g. 3.5.12-15,19-

Thig would copy to pages 3, 5,12, 13, 14,
15 and from 19 to the end of the
document.

B

[ Make thiz a master item on all pages

Cancel |

You can enter in specific pages, or you can type 3- to imply from 3 to the end.
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9b. Master items

e Go to the first page using this button: |'

e In the bottom left corner place a small text writing frame and type your name in

it.

e From the Frames and Pictures menu click on Master items and then choose Make

master item.

22
&)
%J
=
=

g Started with
pictures symbols and words

book about In Print

The following dialog box will open:

Master Page Items i

Cop—
s O
WV &<
BB
Ué W
v BC
als
AP =
P

— Locking
¥ Leave unlocked

[T Lock position
I Lock text and symbols

— Put thiz item

" on left hand pages only
{” on right hand pages anly
* on all pages

— Start Page
% Start from page 1

™ Start from curent page

Far page numbering use ~ instead of the page
rumber in pour test, [Usze shift and the key near the

top left]

Cancel

e Choose the option to put this item on all pages, and Start from page 1

e C(lick the next page button:

—

e Display the booklet in 2 page format: E'EI

@
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You will see the master item is shown on both of these pages. Because it is a master
item, if you make a change to it on page 2 — for example by moving it, or changing
the frame properties, then it will replicate that change on all pages. You can
recognise a Master item because it has Red drag points.

e Put this master item in the bottom right corner of the page.

sl
I |"'I %@ﬁé”hﬂg ﬂ'li
. B|u] 1] s}
&l A% H
2 oy ==
a =0
=| ; BuE
@ | TT\"-!.: ﬁs
| - ®

rabbits in  the forest
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10. Printing

Communicate: In Print lets you print your work in a variety of ways
e From the File menu, select Print to open the Print dialog:

Print 2 x|
— Prirter

MName: magicolor 2200 Deskl aser Properties. . |

Status: Feady
Tupe: magicolor 2200 DeskLazer

Where:  LPT1:
Comment: [~ Frirt ta file
— Print Single or Double Sided
= Book - ready to fold & DDUhl?SidEd Vs
I~ Piirt second side in reverse
" Sheets - ohe page per side
hEERE " Single Sided
— Print range Copie:
& Al MNurnber of copies: |1 3:
 Pages [rom:l'l !DZIB
] [T Callate
 Selection
=

You can choose to print as a book ready to fold in half or as single sheets.

10a. Printing as a book

Printing as a book produces a printout ready to fold into a booklet, with two
document pages per side. It will scale the pages down, so that two pages will fit to

one side of paper. The software calculates which pages to put together so that it all
fits together in the right order when it is printed.

10b. Printing as sheets

If you choose to print as sheets, the software will scale the pages to fit the paper size.
Set as single sided and each page will be full size on a separate sheet. Set as double
sided and it will print odd numbered pages and then ask you to turn the stack to
print the even numbered pages on the back.
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10c. Single sided and double sided

If you choose double sided, it will print all of the ‘top’ sides and then ask you to turn
the stack of paper over ready to print on the other side. You will need to do a test
run to determine two aspects of printing the second side. First you need to test to
check which way round you need to put the paper for the second side. Each printer
type may be different and there will also be a difference if you are printing landscape
or portrait.

You will also need to test in which order the pages are printed on the second side.
You may need to change the setting of the button Print second side in reverse.

Each type of printer may be different and you will need to test and note these details
for each printer that you use. It might be a good idea to put a sticker on the printer
saying what to do. (Section 19 has a guide to printing to help you find out which
settings are right for your printer.)

10d. Paper size

In Print will scale your document to fit the paper size selected in the Print set-up. If
you have A4 paper and choose Print as a book, then the resulting book will be A5. If
you made your document portrait then the book will be ready to fold to the left. If
you have a screen document which is landscape then the book will print so that the
fold is at the top.

If you have A4 paper and choose to print as sheets, then the resulting book will be
A4.

If you have a larger printer with A3 paper then the pages will automatically be scaled
to fit this paper size, either as a book to fold, or as single sheets.

Once you have completed the booklet in this tutorial try printing as both a book
and as sheets.
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11. Saving your preferred settings

You can configure most of the program settings so that the software opens with your
normal preferences. These are saved in the Start-up Preferences under the Options
menu.

There are eight tabs in the Preferences Dialog box:

Frame Appearance
Sets the default appearance of frames.

Wordlists
Sets the main wordlist and a subsidiary wordlist if you want one.

Speech and Spelling
Sets the Speech voice, automatic speech options and whether spelling errors are
shown by default.

Text Graphics
Sets the default font, font size and colour for text and graphic writing, and the
graphic size for these modes plus the default size of graphics added to the page
from the graphics viewer.

Graphic Locations
Sets the path to the Widgit Pictures folder and to two other graphic locations of
your own choice. These can then be easily found by clicking on the Pictures A or
Pictures B buttons at the bottom of the graphic viewer.

Buttons and View
This sets the default Buttons on load, whether the view is single or double page
view and some of the other view settings. You can also set whether you see Rulers
and Print area (the dotted red line around the printable area of the page).

System and Printing
You can set the system to auto-restore in case of problems. Under this tab you can
set the frequency with which the program updates the ‘Auto-restore’ with the
current state of your document.

The print defaults sets the default printing as Book to fold, or as sheets, and
whether the printed pages are to be single or double sided. Remember if you
don’t have a double-sided printer you can still select double sided printing. You
will be instructed when to turn the pages over and re-place them in the printer
tray. (Duplex printers can print both sides in one go.)

Colour Settings
This tab enables you to set whether the program starts with colour or black and
white symbols. It also allows you to set the default skin tone.

You can over-ride these settings at any time while you are working, but these

settings will be restored when you next launch the program. There is more
information on these in the Reference Manual.
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12. Toolbars

The toolbar buttons illustrated throughout this introduction are for the main toolbars
with the full set of buttons available. Also the detail of the buttons changes with

the screen resolution of your computer. The icons shown here are for a resolution of
higher than 1024x768, however other resolutions use different buttons to give you a
maximum work area on the screen.

There are some simpler button sets designed for students.
The toolbar buttons can be changed from the View menu.

The options are:
Advanced

This has the full set of buttons available.

Intermediate

Buttons for a few of the more complex actions are removed, such as insert and delete
pages, bullet points, the text to graphics button and expand the contents of fixed
frame. Also instead of the four ‘front to back’ buttons there are just two — move
forward and move backward.

Basic
This allows creating and writing in Fixed and Free frames, adding graphics, but not

speech bubbles. It also has the ‘“Turn page’ button but not the ones to go directly to
the front or back of a book.

Easiest

This is intended for students who are using ready made templates or on-screen
activities. You can write and add graphics and frames but cannot change to adjust
mode.
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13. Index of Toolbar Buttons
The toolbars change automatically as you change mode or function.
13a. Mode toolbar

There are two modes, changed with the Mode toolbar:

Create

abe | Create Mode
=S

1 Adjust Mode

D New document
Ty

B Open file

E Save

% Print

% Cut

-

EE Copy

e
E Paste

-
' ‘| Duplicate frame and contents

Undo

<\l Redo

{
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Hide panels
Display panels
Edit the palette of a metafile graphic

ﬁ Indicates and changes the display between coloured and
monochrome.

Cycles through the five possible skin tones.

& | (& [

n Create mode the main toolbar also has these buttons:

Speak current sentence - at point of cursor

Calon

<|

Repeat the last speech

Check spelling

O
o
L)

|

]
]
-+

Change the text associated with a word (you can also do this with F11)

B+
5

|

In adjust mode the main toolbar also has this button:

Rotate frame

)

13c. The Page toolbar (independent of mode)

gj so:page:| j ﬂ TotaLPages

Go to first page

AR

Go to previous page

Go to next page. This will also create a new page if there isn't one
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-

N

Go to end of document

Single page view. ( This toggles with double page view)

Double page view (except for page 1, which is always shown as a single
page)

Zoom in

Fit in window

Zoom out

Insert page(s)

Delete page(s)

13d. The Create toolbar

Y| Y
£

The ol
S

The ol
and the
puszycat

|

The ol
and the
puszycat

o < [

Start to write in Symbol mode in a free sized frame
Click on this and then drag a box of the width you want

Start to write in a fixed symbol frame
Click on this and then drag the box to the size you want

Start to write in a free text frame
Click on this and then drag a box of the width you want

Start to write in a fixed text frame, or create an empty frame
for a graphic. Click on this then drag the box to the size you want

Insert a speech bubble

Expand the contents of a frame to be as large as possible

Open the Graphics viewer
Click on this again to close it
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13e. The Edit panel

— Fant

Font

Text or Symbol mode

Set local style

Paragraph alignment
left, centre and right

Font styles, Bold,
Underline, Italic and
Shadow

.— Bullets and Indents

Graphic size, Graphic

—_—

|Cumic Sans MS j
BJ uj 7] sj-
T,
|
a B 5
— Graphics
— %A &
Vv T
—Alignrent
— = <

larger or smaller,
Graphic colour

Vertical alignment

/in fixed frames top,

centre and bottom

S

Hide symbol attached

I
to word

Graphic alternatives display. Click on the
graphic in this window to change the one in the
document. Alternatively click in the word and
then press F9 to cycle through the choices

with F10)

with F10)

B b

LS
=

il

=
=
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Insert bullets
Click again to remove bullets

Indent (top button)
or undo indent (lower button)

Symbol writing mode. Toggles with Text writing mode (Also change this

Text writing mode. Toggles with symbol writing mode (Also change this

Remember the current text and graphic settings for the currently selected
frame type. Only during current writing session. (Use the Options menu
for permanent settings.)




13f. The Adjust toolbar

% Group objects. Click on this and then on each item you want to group, or

Beeatd
dg P

doobf  them.
.=:% Ungroup

E: . |

Arrange

Move to the front

&

D’T Move forward one place

ﬁ] Move backwards one place

Move to the back

[ ——

13g. The Lines panel

N
)

Make wertical and
harizontal lines

Click to start the line, move the
mouse. click again to finish it.

|
I

—&row Style
| —
| —»
<+ || ==

r—Line Thickness

]|

— Line Style

drag over the items with the mouse to group and then click on this to group

Single line
Multiple lines connected
together

Force lines to be horizontal or
vertical. Use this with single or
multi-lines

Line colour
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14. Keyboard Shortcuts

Below is a list of the most common shortcut keys. The full list is given in the Reference

Manual.

Ctrl + A Select all (in the current writing frame)

Ctrl + C Copy the highlighted item(s)

Ctrl + X Cut the highlighted item(s)

Ctrl + V  Paste the copied or cut item(s)

Ctrl + Z Undo last action

Ctrl + Y Re-do

Ctrl + G Group selected items

Ctrl + F Ungroup selected items

Ctrl + Q Send selected item to the back

Ctrl + W Send selected item backwards

Ctrl + E Send selected item forwards

Ctrl + R Send selected item to the front

Ctrl + B Make highlighted text Bold

Ctrl + 1 Make highlighted text Italic

Ctrl + U Make highlighted text Underline

Ctrl + H Make highlighted text Shadow
F9 Cycle through the symbol choices for a word
F10 Toggle between text writing and symbol writing modes
F11 Remove the text linked to a word ready to add alternative text

Ctrl + Shift + Left Click Multiple selection of items on the page

Ctrl + Alt + C Copy selected frame to the Windows clipboard




15. Graphics included with the program

There are two main sets of graphics included with Communicate: In Print 2 - the
Widgit symbols and Widgit Pictures.

15a. Widgit Symbols

This is a set of some 11000+ line drawings to support literacy in both monochrome
and coloured formats. More information is available at www.widgit.com/symbols

The easiest way to access symbols in the program is through a wordlist. The main
wordlist is Widgit (with a version number following). eg. Widgit 08-11.cwl.

An alternative list is Widgit all 08-11.cwl. This also includes all of the graphics from
Widgit Pictures that represent single words. This may be useful in instances, such as
communication books, where you want the colour picture with the word rather than
the line drawing.

15b. Widgit Pictures

There are approximately 1500 coloured pictures also included with the program.
These are normally used direct from the graphics folders (see below) but those
pictures that represent single words can also be accessed through a wordlist. This
may be useful in instances, such as communication books, where you want the colour
picture with the word rather than the line drawing. There is more information on the
wordlists in section 16.

The coloured graphics are organised into topic folders. Most are clear from the folder
titles. The following notes may help you:

e Environment: This has a set of basic backgrounds at the top level, and there are
folders for items that might be used to add to these to make scenes.

e Books: These are the graphics specifically made for some of the example books.

e Colouring in: A small number of pictures are provided in pale colours or shades
of grey which can be used for colouring using the palette editor.

e Patterns: This contains several folders:
Borders borders and page dividers

Colours a small number of items in a range of standard basic colours
for colour work

Numbers numbers in dice layout

Shapes Some basic geometric shapes as filled colour ready to colour
using the palette editor and the same shapes in outline

Money images of UK coins and Australian money.

Gommunicate]n Print2




e People 1 has a range of people and characters to illustrate creative writing.

e People 2 has a number of basic people in different colours and also a sub folder
called Body Parts, which has the bodies and heads separated so that different
combinations can be made.

e Photos has a variety of photographic images organised roughly into topic folders.

® Scenes has a number of compilations of graphics to give ready made scenes.
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16. Wordlists

16a. Wordlists with the program

Communicate: In Print 2 comes with the Widgit symbol set and the coloured Widgit
Pictures. The wordlists are the mechanism by which you select which symbols you use
in symbol writing mode.

A wordlist is a file that links the word and graphic. If you type ‘cat’ into the computer
in symbol mode, then the computer looks up the word ‘cat’ in the wordlist and

so finds out what graphic to produce. You can have different wordlists linked to
different pictures. For example there are wordlists for the Widgit symbols and for the
identifiable objects in the Widgit Picture set. The image produced when you type a
word depends on which wordlist the program has in memory.

The wordlists included with the program are:

Widgit XX.cwl eg Widgit 08-11.cwl where XX is the version number. This is the
complete Widgit symbol collection available at that date.

Widgit Pictures.cwl This is a wordlist for all of the main objects in the Widgit
Pictures folder.

Widgit all 08-11.cwl has all of the pictures and symbols available.

New symbols are available by downloading symbol updates from www.widgit.com/
symbolupdates Each new symbol update is accompanied by a new set of wordlists.
You will need to replace your current wordlist with the new one to access the new
images.

|'-.-'-.-'|:|r|:|Li5I: Edit Miew Text Fr.

Refresh wordlist
Merge wordlist
Replace wordLisk
Show wordlisks
Create empby wordlisk

Save wordlist changes

v Remember symbol choices
Save symbal choices

IUse calours From wordlisk
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16b. Creating your own wordlist

You can also create a new wordlist to add your own pictures or word changes. From
the Wordlist menu, choose Create empty wordlist.

Create a document that includes your new words. These may be existing symbols or
pictures with new words attached, or new images added to a word. For example - to
add a set of photographs of people in a group. Type their names into the document,
and then drop their photos onto the words.

When you are ready, select Save Wordlist Changes from the Wordlist menu.

Export to Wordlist

Chaose the wordiist to vidait 03-11. ol
export to

Wards to export

ke Change word if required

tina percy
Add |

Add 4l |

Fesouice area

My Resources 2 -
Delete all |

Resource folder

Delete | graphl -
Make new resource folder

Select the wordlist you want to add at the top of the dialog box, and then highlight
the items from the list that you want to add. Click Add to add to the wordlist and
click Done when all your changes are made. These lists are called subsidiary wordlists.

You can use a main wordlist, such as the ones described above, together with a
subsidiary wordlist with specific vocabulary. Choose Merge wordlist from the Wordlist
menu to open the second list.

16¢. Setting the default wordlist

If you want to always use a wordlist other than the one that was supplied with
the program when you purchased it, then you should change the default list from
the Options/Start-up Preferences menu. You can also choose a default subsidiary
wordlist that will also open automatically when you start the program.

Set Start-up Preferences x|

Systemand Piinting | Graphic Locations | Tes/Graphics | Colow Settings |
Frame Appearance  Wodists | Speechand Speling | Buttons and View

Set up your default word lists
- Main Word

i ordlistiwidgit 0811wl

1f you wish you may alsa load an optional subsidiary word fist, such as a small
sef of photos of local symbols.

~ Subsidiary ‘Wordi

Browse to change Remove subsidiary list

" phic preferenc:
agram [You can remember them permanently befare you
chasing the Wardlit menc:. 'Save graphic praferences

' Yes [ chaose this unless you regulary use an overlay keyboard] ' No

0K
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16d. The Wordlist Manager

There is a utility program called the Wordlist Manager. This program allows you to
edit wordlists, to create new ones and to merge existing lists to make longer ones.

This utility is supplied with Communicate: Symwriter. You can access it by installing
the trial version of Communicate: Symwriter. It will remain available on your machine
after the trial has expired. More information and a download is available from
www.widgit.com/support/wordlistmanager

If you are editing a wordlist in the Wordlist Manager, whilst you have Communicate:
In Print open, you will need to refresh the wordlist in Communicate: In Print in
order to see your changes immediately. To do this go to the Wordlist menu and click
Refresh wordlist.

16e. Using other Wordlists

It is possible to use wordlists from Writing with Symbols 2000 in Communicate: In
Print. The wordlists are of a slightly different format and although you can use WWS
2000 wordlists in the software, you cannot use the Communicate: In Print 2 wordlists
in Writing with Symbols unless you convert them. You can convert wordlists in the
Resource Manager that is supplied with Communicate: In Print.
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17. Ideas of things to do

These ideas are designed to help you practice some of the techniques described in this
book and give some additional tips. The examples are included in your Communicate
Files\In Print Writing folder. The books are in the Examples\Books to Print folder and
the worksheets are in the Examples\Worksheets and resources folder. Also in the In
Print Writing folder there is a folder called Templates. This has a number of ready-
made layouts for you to use. You can save any of your own layouts in this folder as
Templates.

1. A picture book with symbol captions

Example Forest Book

They were  squirrels

H-m 5

They were eating nuts

The paper is Landscape.

Guides have been placed to mark the top and bottom of the pictures and for the text
lines.

A small frame has the page numbers in.

In the version Forest Book, only the odd numbered pages have been filled in so that
the book can be printed as an A5 book folded.

Another version, called Forest has each page done for printing as sheets — either
double sided or single sided.

Other examples of this type of book are Vikings, and the Christmas Story.
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2. A simple counting book

This book can be made from the template Counting 1-9 empty:

- | KX
&

@
&

- - ]F I ! | ! l

SR B I * 5 red tomatoes *

If you are using the template, you only need to add the pictures and the text. If you
click on the number at the bottom of the page you will see a locked frame. Locked
frames have grey drag points. A frame can have its position locked or its contents
locked, or both. This one has the position only locked. This means that the student
can't delete or move the frame itself, only the contents.

If you are making a book like this from scratch, you can plan the book, making all
of the pages with their frames ready, but without adding the content, and then
save it into the Templates folder. Files saved in the Templates folder cannot easily be
overwritten.

Another example is ‘Counting Food’, from the ‘Books to Print’ folder.
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3. A book in text and symbols

Example Tortoise and Hare

E-SE | @“’i’ﬁ\&

Tortoise  challenged Hare to a race

Zow el

Hare laughed and said I will  win

me—Fime—summers—dayHarry—He—tar Hefmyetomg;—ard
boasting as usual about how fast he was. He said that no ane in the
forest could beaf him. Today, though, Tom the fortoise thought fo
himseHE "I'} show him—a lessonl” and soh gedHarey to g

race. Harry laughed aut loud when Tom suggested this, "You'll never
beat me " he said. Well," said Tam, "Why don't you give me a head
start?" Harry agreed, so the race was set for the next day in the
big field.

R |

This has the story in text on one page, and opposite a simpler text with symbols.

The picture was placed on the left hand page and copied (CTRL+C), then pasted on
the next page (CTRL+V). This placed the graphic at the same size and in the same
position as on the first page.

In the symbol story the text has been adjusted so that there is one sentence to each
line.

Print this Landscape, double sided as sheets, and bind it on the left, to open flat as
shown. If you choose to print it as a book the pages will be printed so that they are
one above the other as you open it.

Marry sterind chousing sst ta Tom. Horry up sewsceck] Yeu'l sever Baat
e iy oy on e el

Enewinally, Tom orrmed m the siwri e A groai bash oee sepe e
stching createnes an the roce s chaut o atert. Mary by back in the
s wed el Tom bhave She hood short he had promised him TF was sie ond
s, Harry- thaghtt 82 hirssell, *t coakl e @ dooe e £ enteh up
-t T 8

My, Tom plecdad wlusky @

Z—® X B a 4

Hara @y In e sun W ist  Tomoss calchup.

& A4 F

Hara  thought | un sa fast | can sl win.
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4. An Odd one Out book

Example Odd one Out

Whith one Iz different?

%&kww&J
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Which ene iz upszide down?
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(23318
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EEEEE)
Peeee®)
(ke
(4 ¥ 34 3)

The pages have been marked with guides using the rulers to mark out the squares
where the images will be placed.

Make a single frame on your page.

From the frames menu, set the Appearance to be:
corner radius 5; line thickness 6; border width 12 and internal space 1.

Right click in it to re-size it so that it appears like the illustration above, with 5
clear squares inside ready for the pictures.

Go to Frames menu and Make a table 1 frame wide and 7 frames down. If it
doesn’t exactly fit the space you can adjust it using the Yellow drag points.

Lock this in position.

Then copy this frame to all of the pages in your book except the covers. You can
choose to have it locked on each page.

IMPORTANT: Change to Adjust mode. Now when you add the graphic it will sit on top
of the frame and not be placed in it.

You can now add different graphics to each line, varying them by flipping or
colouring to make the different exercises.
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5. Activity book

This book has a number of activities in black and white line drawings suitable for
printing as worksheets.

Page 1.
The items are typed into frames and then the text set to be white. This will ensure
that there is enough space for the student to write under the picture.

Page 3.

These pictures are obtained using the Use List tab on the graphics Panel. Type the
names of a number of words beginning with C into the list to find suitable objects,
and then add some distracters.

The size the graphics automatically appear is set in the Start-up Preferences box,
under the Text Graphics tab. This is the bottom box, labelled Drop in graphics. A
suitable size as in this example is 36.

Page 7.

The sets of three squares for the spelling activity can be made as a small table. Each
one can then be copied and pasted to line up with the symbol on the left.

6. Worksheets
Example worksheets are in the Examples\Worksheets and Resources folder.
The worksheet Making Tea has one Fixed Symbol writing frame with the title. A Free

symbol writing frame and 1 vertical set of pictures (taken from the Photos folder) and
a vertical line to separate the words from photos.
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Making Tea
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Who is wearing these clothes?

Worksheet 1

There are many worksheets that can be made with the Template Worksheet 1. Type
the instructions into the top frame and add the pictures to the frames in the table.
In this example the pictures were added from the Graphics viewer. Alternatively type
into the frames and get both picture and word.

Q2 9]0 |l e

Down l
1 4P
2 &
3 4f
4 o
¢ &
o O
"
10
13 Ty
5 3
C
17 @

This crossword uses tables for the crossword itself and for the clues. To make the table
for crossword from the Fixed Text button, make a small frame with the line width

4, and the other settings 1. Size it for one square in the crossword. Set the font size
small for the numbers.

Then make a table from that with the number of squares you want. The coloured
squares are made by setting the frame Appearance, background colour.

The tables for the clues are made in a similar fashion but when they are all completed
highlight the whole table and set the line colour transparent. (It is easier to work
with the lines visible while you are making it.)

“(:>

{communicate:m Print 2@



18. Managing files and getting students started

18a. Where work is stored

The main work files that you will need to access are stored in a folder called
Communicate Files. On a stand alone machine the default location for this is C:\
Communicate Files.

In the Communicate Files folder there is a folder called In Print Writing, which holds
all of your work saved from Communicate: In Print. This also includes Examples, which
has examples of many different types of materials you can create in Communicate: In
Print, a folder of Templates, which are frameworks for further work, and an In Print
Starters folder.

18b. Where the graphics are stored

The coloured pictures supplied with the program are in a folder called Widgit
Pictures. The symbols are in a folder called Widresources. There is also a folder called
Shared Pictures, where you could store your own pictures that you want to use in
the program. At the bottom of the Graphics Panel there are shortcut buttons to the
Widgit Pictures folder and to two other buttons. By default Button A links to your
My Pictures folder in My Documents, and Button B links to the Shared Pictures folder.
You can, however, change these links in the Start-up Preferences (found under the
Options menu).

18c. Working on a network or a machine that has an individual log-on

If you are working on a machine or network that has different log-in levels for
teachers and students then you will need access to the whole of the Communicate
Files folder. Students can have access just to their own work folder, as set up on the
network. If you would like individual students to have access to materials from the In
Print Writing folder you need to copy them into the In Print Starters folder. When an
individual student logs on to Communicate: In Print, any files that are in the In Print
Starters will be copied into their own area in their own In Print Starters folder ready
to use.

18d. Setting work for students

To start a student off with some templates or prepared materials, save them to your
In Print Starters folder. These are copied to the student’s area when the student runs
the program. You can remove the files from your folder later if you wish.
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19 Print test

Different printers vary in the way that they handle paper. In most cases you don’t
worry about this because you only print on one side of the paper. However, if you
want to print double sided from a non-duplex printer, you need to understand
which way the printer handles the paper. This applies whichever application you are
printing from.

19a. Which side of the paper does your printer print on?

Put an X in the leading edge of the paper as it goes into the Printer. Print a single
page document (Print Test 1) (or a single page document from any other program).

Do you print on the same side as the X or on the opposite side?
If it is on the same side of the paper as the X then when you replace the paper into
the feeder tray to print on the reverse side, the non-printed side(s) should be face up

(or towards the printer).

If the printing is on the opposite side, then you need to make sure that the non-
printed side of the sheet(s) face down (or away from the printer).

19b. Which edge of the printed paper goes into the leading edge of the
printer feeder tray?

When you are printing pages as sheets, the leading edge of the page (where the X
was), is the top of the page. When you place the paper back in the tray you need to
make sure that this same edge is again at the leading edge (but with the non-printed

side ready to print). In the case of printing as sheets, this will normally mean that you
take the paper out of the paper tray after printing and rotate it by 180 degrees.

Abc
qQy

Test this by printing a four page document ‘Portrait Printing Test’ (You could also try
this with a document from any other program such as MS Word).

Set the printer dialog box to be Print as Sheets - one page per side, Double sided, and
tick the box (Print second side in reverse).
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— Printer

Mame: magicolor 2200 DesklLagser Properties.... |

Status: Ready

Type: magicolor 2200 Desklazer

Where:  LPTT:
Camment; [ Print ta file
— Print Az Single or Double Sided

" Double Sided

" Book - ready ko fold ; ol
v Print second side in reverze

' Sheets - one page per side

" Single Sided
— Print range Copies
= 4l Mumber of copies: |1 3:
 Pages _flom:|1 _tl:u:|4
! [™ | Callate
" Selection

Print the first side.
The following message will appear:

merint x|

& Wit till all of the first sides have printed, then turn the stack over, Then click OF to continue ko prink,

Cancel |

Take the paper out, rotate it by 180 degrees (as shown on the previous page) and
replace it in the feeder tray with the non-print side ready to be printed. Then click OK
to send the other sides to print.

Look at the results of the printing test you have done.

If the second side is upside down, then you don’t need to rotate the paper by 180
degrees between printing the first and second sides of Portrait Sheets.

19¢. The order in which the pages are delivered

Is Page 2 on the back of page 1 or not? If page 4 is on the back of page 1 (instead of
page 2) then you will need to set the default for Print second side in reverse to be

OFF.

If necessary re-print the test for printing sheets, double sided, to ensure that you have
the correct settings.
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19d. Printing other documents

The setting for Print second side in reverse will be the same for all documents printed
on that printer.

Also the way that the pile of paper is presented to the printer with the side to print
face down or face up will be the same for all documents.

The aspect that will change between different types of publication will be the
horizontal rotation of the paper.

A Printing Landscape Sheets

Open the file ‘landscape printing test’, and print that also as double sided sheets. You
will find that the settings will be the same, except that you will probably not need to
rotate the paper between printing the first and second sides.

Record the results for correct printing in the form on page 4 of this document.

B Printing Portrait Books
Print this document ‘Portrait printing test’ with the settings as Book - ready to Fold

and double sided. You will probably NOT have to rotate the paper between printing
the first side and the second sides.

C Printing Landscape Books

Print the file ‘landscape printing test’, a book, ready to fold, double sided. You
probably WILL have to rotate the paper between printing the first side and the
second sides.

e Copy this settings chart and put it by the printer as a reminder.

Test for Printing Double Sided Sheets
Name of printer:

Print second side in reverse ON OFF

Place second side to print face up face down

Printing Portrait sheets:
* Rotate paper before second side printing YES NO

Printing Landscape sheets:
* Rotate paper before second side printing YES NO

Printing Portrait Book ready to fold.
* Rotate paper before second side printing YES NO

Printing Landscape Book ready to fold.
* Rotate paper before second side printing YES NO
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